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If you delete any lines on this page, retain the hidden Section Break below that provides proper page-number format.  To see the Section Break, click the Home tab > Paragraph section >[image: ]icon.  On a Mac, the icon may be above the ribb. 
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[bookmark: Chapter1][bookmark: _Toc472673204]Introduction and Report Information
{Add content here.  See Chapter 5 for details on using the ETDR template.}

[bookmark: _Toc400643742][bookmark: _Toc472673205]Introduction and Statement of Purpose
{write an introduction to your masters report describing the purpose of the project, what will be included in the report, what you learned through the process, and how you intend to use your learning in your future career}

[bookmark: _Toc222020682][bookmark: _Toc400643743][bookmark: _Toc472673206]Performance Information
{include the date, place, time, personnel, and any other pertinent information concerning the performance}

[bookmark: _Toc222020683][bookmark: _Toc400643744][bookmark: _Toc472673207]Music Examined
(introduce the musical selections, composers and educational reasoning for the selections}

[bookmark: _Toc222020684][bookmark: _Toc400643745][bookmark: _Toc472673208]Format of Analysis
{provide an overview of the format used in this paper for analysis of each piece}

[bookmark: _Toc222020685][bookmark: _Toc400643746][bookmark: _Toc472673209]Concert Program
{include the concert program}



[bookmark: _Toc472673210]Music Education Mission Statement
{This is your philosophy of music education. Be certain to include the following: (1) why we teach music in school and how it fits into the overall purpose of schooling; (2) your theories of student learning and theories on how you can influence student learning through the process of teaching; (3) philosophical support that describes the purpose of such thorough score analysis and rehearsal planning; (4) beliefs relating to high achievement, respect for diversity, classroom environment, and your professional responsibility for these elements.  Support your beliefs with scholarly references when possible}  



[bookmark: _Toc472673211]Quality Literature Selection
{Thoroughly describe your beliefs and reasoning behind selecting quality literature as an ensemble director. Include rationale used for selecting general literature selection, connections to overall curricular purposes, and related literature that supports your rationale for literature selection. You may use the subheadings below if you want to organize your data by topic.  For additional subheadings, copy the format and add the titles and narrative}



[bookmark: _Toc222020692][bookmark: _Toc400643752][bookmark: _Toc472673212][name of concert selection]
This chapter is included to show a few more examples of headings, subheads, figures, and tables. You can add as many chapters as needed for your ETDR.
[bookmark: _Toc222020693][bookmark: _Toc400643753][bookmark: _Toc472673213]Unit I. Composer
{include a thorough biographical narrative of the composer making specific connection to this composition. Be certain to include the reference citations for all data and quotations}
[bookmark: _Toc222020697][bookmark: _Toc400643755][bookmark: _Toc472673214]Unit II. Composition
{Include a thorough description of the composition such as general background,  cultural relevance, unique instrumentation, and any other information that would provide an understanding of the piece}
[bookmark: _Toc222020700][bookmark: _Toc400643756][bookmark: _Toc472673215]Unit III. Historical Perspective
{Include a thorough background of the historical background relevant to this composition}
[bookmark: _Toc222020704][bookmark: _Toc400643757][bookmark: _Toc472673216]Unit IV. Technical Considerations
{This section should be detailed with all technical considerations important to a conductor elaborating and referencing the elements indicated on the score analysis form. Include specific measure numbers, instruments involved, description of the technical challenge and proposed solutions. Also expose important rehearsal considerations referencing the lesson plans when applicable}
[bookmark: _Toc222020708][bookmark: _Toc400643758][bookmark: _Toc472673217]Unit V. Stylistic Considerations
{This section exposes specific stylistic considerations required for effective performance. These should elaborate on and reference the score analysis form. Include specific measure numbers, instruments involved, description of the stylistic challenge and proposed solutions. Also expose important rehearsal considerations referencing the lesson plans when applicable}
[bookmark: _Toc222020712][bookmark: _Toc400643759][bookmark: _Toc472673218]Unit VI. Musical Elements
{This section exposes specific musical considerations required for expressive performance. These should elaborate on and reference the score analysis form. Include specific measure numbers, instruments involved, description of the musical challenge and proposed solutions. Also expose important rehearsal considerations referencing the lesson plans when applicable}
[bookmark: _Toc222020716][bookmark: _Toc400643760][bookmark: _Toc472673219]Unit VII. Form and Structure
{Provide your overview of the formal structure of the composition. Include relevant information important to the conductor with measure numbers, relevant instrumentation elements, and other necessary information}
[bookmark: _Toc222020717][bookmark: _Toc400643761][bookmark: _Toc472673220]Unit VIII. Suggested Listening
 {provide a list of suggested listening exposing the aspect for which to listen}
[bookmark: _Toc222020718][bookmark: _Toc400643762][bookmark: _Toc472673221]Unit IX. Seating Chart and Acoustical Justification
 {describe the seating chart and provide rational support the decisions made in reference to acoustical principles}
[bookmark: _Toc222020825]

[bookmark: _Toc400643724][bookmark: _Toc472673245]Figure 4.1 Seating Chart
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[bookmark: _Toc222020719][bookmark: _Toc400643763][bookmark: _Toc472673222]Unit X. Rehearsal Plans and Evaluations

[bookmark: _Toc222020720][bookmark: _Toc400643764][bookmark: _Toc472673223]Rehearsal Plan – Rehearsal #1
Ensemble: 	Announcements: 

Literature:	Time:
Evaluation
1. 
Title
1. 
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Literature:	Time:
Evaluation
1. 
Title
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Duplicate this additional chapters in this format as needed. Follow these steps: 
1. Insert a Page Break.
2. Type the headline that you want in regular text.
3. Select the text and apply a “Heading 1” style.
4. Copy the content from the template above to the new chapter.
5. Repeat as necessary.



[bookmark: _Toc458512425][bookmark: _Toc472673225]EXAMPLES and TIPS (this is a Heading 1)
(Delete this chapter before publishing!)
Timesaving elements like headings, and caption labels for figures and tables, are shown below.  You can modify headings and other styles to meet departmental requirements.  Find your Word version at k-state.edu/grad/etdr/word and read the “Using Styles” section.
[bookmark: _Toc458512426][bookmark: _Toc472673226]YOU control the format of your content (Heading 2 example)
From Chapter 1 and on, you and your adviser decide how to format the content.  The Graduate School wants consistency, so it will check your content for format issues such as: 
Blank pages
Figures and tables outside the margins 
Inconsistent line spacing, margins, page numbering, etc.

[bookmark: _Toc458512427][bookmark: _Toc472673227]Use headings and subheadings to organize content (Heading 3 example)
Headings 1-5 are for use in chapters (headings 6-9 are for appendices).  Many students only use Headings 1, 2, and 3 in chapters.  To organize a Heading 3 section, use Heading 4’s.
[bookmark: _Toc458512428][bookmark: _Toc472673228]Heading 4 is special; it can also be put in a paragraph (Heading 4 example)
Notice that Heading 4 has a half-inch indent.  This heading is designed to stand alone on a line or to fit inside a paragraph (which some students need for APA style).
[bookmark: _Toc458512429][bookmark: _Toc472673229]Heading 5 also fits inside a paragraph (Heading 5 example).  Be aware that headings inside a paragraph will be shown in the Table of Contents, but do not display in Word’s Navigation Pane.
[bookmark: _Toc458512430][bookmark: _Toc472673230]Adding figure and table captions
In chapters, each figure and table must have a caption/label, and each caption must be included in the List of Figures or List of Tables.  The easiest way is to INSERT a caption, which lets Word do all the work (applies Caption style, adds numbering, checks sequence, etc.).
In Word for Windows:  References > Captions section > Insert Caption
In Word for Mac:  Insert > Caption

[bookmark: _Toc458512431][bookmark: _Toc472673231]First, ask your adviser about caption format 
Your adviser may want your captions to look a particular way.  The Graduate School wants consistency, so the actual format is up to you and your adviser.  Consider these: 
Single- or double-spaced?  Bold or not?  Centered or left-justified?
Figures: Place captions above or below the image?
Tables:  Put captions above or below?

[bookmark: _Toc458512432][bookmark: _Toc472673232]Second, set your caption style for figures, then tables (must be trained separately)
1. Train your first figure caption.  For details, see “Captions for figures and tables” for your Word version at k-state.edu/grad/etdr/word.  
2. Train your first table caption.  
3. From then on, simply insert a caption (Insert > Caption); make sure the label is set to Figure or Table; and click OK.
[bookmark: _Toc458512433][bookmark: _Toc472673233]EXAMPLES
[image: ]
[bookmark: _Toc458512439][bookmark: _Toc472673246]Figure 5.1 Figure captions in the ETDR template are now set below images by default.  You can change that and other formatting.
[image: ]
[bookmark: _Toc458512440][bookmark: _Toc472673247]Figure 5.2 EXAMPLE of correct formatting on an ETDR title page. All details are important, including punctuation, capitalization, and the blank line after “Approved by:”.

[bookmark: _Toc458512442][bookmark: _Toc472673250]Table 5.1 Table captions in the ETDR template are set above tables by default.  You can change that and other formatting.  
	Table Text style (optional) puts even spacing above and below cell content

	Section 
	A
	B
	C
	D

	1
	A1
	B1
	C1
	D1

	2
	A2
	B2
	C2
	D2

	3
	A3
	B3
	C3
	D3



Table guidelines:
You and your adviser control table size, placement, page layout (Portrait or Landscape), appearance, fonts, and other details.  Page size is not limited.
If needed, tables and figures can extend one-half inch into the left and right margins. 
Tables must be legible in electronic and printed formats.

[bookmark: _Toc458512443][bookmark: _Toc472673251]Table 5.2 EXAMPLE of an APA-formatted table.  APA style is not an ETDR requirement.
	A-D
	A
	B
	
	C
	D

	1
	A1
	B1
	
	C1
	D1

	2
	A2
	B2
	
	C2
	D2

	3
	A3
	B3
	
	C3
	D3


Note. EXAMPLE of an APA table note (using a Table Note style). This is not an ETDR requirement. 

[bookmark: _Toc458512434][bookmark: _Toc472673234]Difference between chapters and appendices
Chapters contain essential information, including tables and figures.  Appendices are for supplemental data. There’s no limit on the number of chapters or appendices.
From Chapter 1 on, the content and format of your research is up to you, your adviser(s), and your graduate committee.  You have many choices on fonts, headings, paragraph style, tables, captions, etc.  Consistency is essential. 
For details, see the Graduate School Requirements and Guidelines for Electronic Theses, Dissertations, and Reports at k-state.edu/grad/etdr/create/guidelines.html.

[bookmark: _Toc458512435][bookmark: _Toc472673235]Quick tips for using the ETDR template, resources, and Word styles
 “I wish I would have used the template earlier!” is a common lament by graduate students.  Save yourself time and stress by learning to use features in the ETDR templates.
1.  When you start writing, use an ETDR template.  If you only need one chapter, make a copy of the template and delete everything except Chapter 1.
2.  Get a head start with short videos and resources for the ETDR template.  
Windows Word 2010 (also good for 2013-2016): 
Word 2010 resources > Configure Word 2010 for the ETDR Template
Mac Word 2011 (also good for 2016):
Word for Mac 2011 resources > Configure Word … Word for Mac 2011

3.  Get ETDR help sooner.  Don’t wait until you’re near to finishing.
Attend ETDR walk-in clinics and presentations, listed on the ETDR homepage.
Use the ETDR Service Request form to get a meeting in person or by webconference.
Contact the IT Help Desk, 785-532-7722, helpdesk@k-state.edu.
Use resources on the ETDR website.

4.  Learn to use styles, which have time-saving features.  A style a set of formatting characteristics such as font size, indents, line spacing, alignment, etc.  When you modify a style, it changes all text using that style.  You can modify styles in the ETDR Word template to meet your departmental requirements. Those styles include:
Bibliography = for citations; single-spaced, hanging indent, and a blank line after. 
Body Text = for basic content; double-spaced with a paragraph indent.
Caption = for labeling figures and tables.
Heading 1 = for “Chapter” title in 1, 2, 3 format.
Headings 2-5 = for subheadings in chapters. 
Heading 6 = for “Appendix” title in A, B, C format.
Headings 7-9 = for appendix subheadings.
Page Heading = for sections names not to be in the Table of Contents (like Abstract).
Page Heading TOC = for section names that must be in the Table of Contents.
Table Text = for even spacing top/bottom/left in cells; single-spaced Normal font.


[bookmark: _Toc472673236]HOW TO USE THE ETDR TEMPLATE
(delete this chapter before publishing)
[bookmark: _Toc472673237]Chapters and appendices
Chapters should contain your essential information, including tables and figures.  Appendices are for supplemental data that you want to include.
There’s no limit on the number of chapters or appendices.
From Chapter 1 on, the content and format of your research is up to you, your adviser(s), and your graduate committee.  You have many choices on fonts, headings, paragraph style, tables, captions, etc.  Consistency is essential. 
For details, see the Graduate School Requirements and Guidelines for Electronic Theses, Dissertations, and Reports at k-state.edu/grad/etdr/create/guidelines.html.

[bookmark: _Toc419474312][bookmark: _Toc472673238]Special styles in this template
This template uses “styles” time-saving features in Word. A style is a combination of formatting characteristics (similar to clothing styles and vehicle styles).  It can include font size, color, line spacing, paragraph alignment, and more.  See Chapter 4 for examples using some of these styles.
· Heading 1 provides a “Chapter” title in 1, 2, 3 format.
· Headings 2-5 are for subheadings in chapters.
· Heading 6 provides an “Appendix” title in A, B, C format.
· Headings 7-9 are for appendix subheadings.
· Body Text is for basic content and is double-spaced with a paragraph indent.
· Bibliography is single-spaced, with a hanging indent and a blank line after. 
· Caption is for labeling figures and tables.
· Page Heading is used on sections headings such as Abstract and Copyright.
· Page Heading TOC is for section headings that must display in the Table of Contents.
· Table Text is a Normal font that’s single-spaced, with even margins all around.

[bookmark: _Toc419474313][bookmark: _Toc472673239]Benefits of using styles to save time
1. Fast updates of the Table of Contents, List of Figures, and List of Tables. 
Put your cursor in the content field, right-click, and select Update Field. 
(Sometimes a window pops up. Click Update entire table and OK.)

2. Headings create a roadmap for fast and easy navigation. 
Use the clickable outline in the Navigation Pane (View > Navigation Pane).

3. Modifying a style in the Styles Menu will change all occurrences in your document. To display the Styles Menu in Windows: Home tab > Styles section > click small arrow in bottom right corner.  To display it in Mac: Toolbox icon > Styles tab.  


Contact the IT Help Desk, 785-532-7722, helpdesk@k-state.edu, if you need assistance.



[bookmark: _Toc458512436][bookmark: _Toc472673240]References or Bibliography (choose one)
Include a separate chapter for your references or bibliography.  Citations can be single- or double-spaced.  They must be followed by a blank line.  The rest of the format is entirely up to you and your adviser.
A Bibliography style in this template (with single spacing, hanging indent, and a blank line afterward) meets the needs of many students.  You can modify it as needed.  Examples: 

Devine, P. G., & Sherman, S. J. (1992). Intuitive versus rational judgment and the role of stereotyping in the human condition: Kirk or Spock? Psychological Inquiry, 3(2), 153-159.
Hodges, F. M. (2003). The promised planet: Alliances and struggles of the gerontocracy in American television science fiction of the 1960s. The Aging Male, 6(3), 175-182.
James, N. E. (1988). Two sides of paradise: The Eden myth according to Kirk and Spock. In D. Palumbo (Ed.), Spectrum of the fantastic (pp. 219-223). Westport, CT: Greenwood.

The Bibliography style does not format your citations into a specific style such as American Psychological Association (APA) or Modern Language Association (MLA).  You must enter your citations in the style used by your department, or use bibliographic software such as RefWorks, EndNote, or Mendeley.
For assistance with citations, contact K-State Libraries (www.lib.k-state.edu) and see its Citations and Bibliographies information at guides.lib.k-state.edu/citations.


[bookmark: _Toc472673241]Enter Your Appendix Title Here
This area is used for your score analysis and supplemental data.
There’s no limit on the number of appendices.
Appendix headings must be labeled A, B, C, etc. 
For instructions see the following web links 
· SCORE ANALYSIS TEMPLATE 
· Instruction for completing Score Analysis
· Inserting Score Analysis into Report


[bookmark: _Toc472673242]Figure and table captions in appendices
Captions can include the chapter number and appendix alphabetical designations, or can be listed as Figures 1, 2, 3, and Table 1, 2, 3, etc.  Visit with your adviser to determine the caption styles and placement that meet your department’s requirements.
Microsoft Word has trouble dealing with the complexity of numbered chapters versus alphabetical appendices.  If you decide to include chapter/appendix designations in caption labels, inserting a caption in an appendix will cause it to be labeled as though it were in a chapter.  For example:  The figure caption below was labeled “Figure 6.1” when inserted but is required to be “Figure A.1”.
[bookmark: _Toc472673248]Figure A.1 Correct caption in Appendix A.  See the ETDR website for instructions on changing appendix captions. 
[image: MP00640_] 
For a way to fix appendix caption labels, see the Appendices section for your Word version on the ETDR website at k-state.edu/grad/etdr/word.
[bookmark: _Toc458512438][bookmark: _Toc472673243]
Using appendices, adding more, adding captions
Appendices are optional and are for supplemental data, meaning anything you and your adviser want to add that helps explain your research, including survey tools, images, data sets, programming code, letters and forms (usually in PDF format), etc.
Appendix headings must be labeled A, B, C, etc.  (Tip: Use Heading 6.)
Heading styles 7, 8, and 9 in the ETDR template are for appendix subheadings.
There is no limit on the number of appendices.

Adding more appendices
1. Insert a Page Break (Insert > Page Break), so the next appendix starts on a new page.
2. Type the name of the appendix and apply a Heading 6 style (Home > Heading 6).  
3. Word provides the “Appendix” label and correct alphabetical sequence.
Adding appendix captions
If captions in your chapters are numbered 1, 2, 3, etc., that numbering format should continue through your appendix captions.  If captions in chapters are numbered 1.1, 1.2, 1.3, etc., your appendix captions must match that format by using A.1, A.2, A.3, etc.
[image: MP00640_] 
[bookmark: _Toc458512441][bookmark: _Toc472673249]Figure B.1 EXAMPLE of caption in Appendix B, with appendix identifier and number.

A common problem with appendix captions is that Word will label them as though they’re in a chapter (“Figure B.1” above was originally “Figure 6.1”).  
One solution: Carefully delete the chapter number and type in the desired appendix identifier, without changing the figure number.  NOTE: It’s best to do this after you’ve inserted all your captions, or Word may add chapter numbers again whenever you insert a new caption.

[bookmark: _Toc472673244]Enter Your Appendix Title Here
If you need additional appendices, follow these steps: 
1. Insert a Page Break.
2. Type the headline that you want in regular text.
3. Select the text and apply a “Heading 6” style.  
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